* viverzk

IB9368-HT
|89388-HT Bullet Network Camera

User’'s Manual

2MP/5MP « Outdoor « IP66 « IK10 « Day & Night « Remote Focus

WDR Pro « Smart Stream Ill « SNV « 30M Smart IR




Table of Contents

L 1YY 1 S 3
AV ] To] o T o 15 o] PP 4
[RNCT= o == o Ty T U T SR PRR 4
[ Tt 1= T =T 0 o] o1 £= 1 Y £ SE S RRRT 5
Symbols and Statements in thisS DOCUMENT............oii e e e 5
)V To= T =TT o o] (T o PRSP 6
Hardware INSTAIALION ...ttt ettt ettt e e s ae bt e e e e s be et e e e s annaeeeeeannneeeas 8
SOftWArE INSTAIALION ..ottt st a e e b e e sab e e e nbe e e sabe e e eabe e e sbeeeennee 14
=Ty QD T=T o1 (o) 0 1 =T o | PP 21
== Lo LV (o TN U F T PRSP 22

Accessing the NetWOrk Camera ... s 25
USING WED BIrOWSEIS ...ttt ettt e ettt e e oo h bt e e oo s b bt e e e e bttt e e e e s mbee e e e e enbeeeeeeannbeeeeeennees 25
USING RTSP PIAYETS......coiiiiiiiiiee ettt ettt e e e ettt e e e e sttt e e e e e astee e e e e ssteeeeaastaeeeeeasbeeaeeeansaeeeeeanstanaeeennnees 28
Using 3GPP-compatible MODIlE DEVICES........c.uuiiieiiiiiie et s e e e e 29
Using VIVOTEK ReCOrding SOfWAIE .........coiiiiiiiiie ettt e e eee e e e e sntae e e e e st e e e e e annaeeeeeennees 30

1Y =TT I == Vo 1= TSSO ST PP 31

ClIENT SEHINGS ... s s e e e s 36

(@70] 01 {To 18] =1 (0] o SRS PR ST PRPRPRTURN 41
SyStEM > GENEIAl SEHINGS ... eeiiii ettt e e e ettt e e e e aatee e e e e steeeeeaasteeeeesasteeeeesansaeeaananns 42
System > HOMEPAGE [QYOUL ......oooiiiiiie et e et e e e e bt e e e e aa b e e e e e e sbbe e e e e s anbeeeeaeanns 44
Y1010 0l 1o o RO 47
SYSIEM > PArameEters ......oooiiiiiiii ittt ettt e e e bttt e e e et ee e e e e b be e e e e e et e e e e e e e nbe e e e e e abreeeaean 49
SYSIEM > MAINTENANCE .....cei ittt e e e ettt e e e e ea et e e e e sastteeeesaateeeeessteeeeeaanteeeaesaassaeeeesansseneaeanns 50
Y T=To E= Tl 10 = To = PR 54
Y [=To [ F= TV o =T OO PP PP PP PPPRPPRN 68
Y T=To [ E= TV o =Y o R PR 69
Y [=To [ F= TV o =T OO PP PP PP PPPRPPRN 70
NEtWOrK > GeNEral SEHINGS .....coii ittt e e et e e e b b e e e e e e nbe e e e e e annbe e e e e e nees 79
Network > Streaming ProtOCOIS .......oiiiiiiiiiei ittt e e e et e e e e e et te e e e e s nte e e e e e snbeeeeesnbeeaeeeanneeeeeeeneees 86
Network > SNMP (Simple Network Management Protocol) .............c.eeuvvveeiiiiiiiiiieee e 95
=5 e el I T P PP PP PP PPPRPPRN 96
SECUNLY > USEI @CCOUNTS ...ttt ettt e e e a et e e e e e be et e e e e aab et e e e et beeeeeaanbeeeeeeanbbeeeeesanbeeeeaeanns 97
Security > HTTPS (Hypertext Transfer Protocol over SSL) .o 99
SECUNLY > ACCESS LIST ..ottt e ettt e e sttt e e e s nee e e e e s anbbe e e e e annneeeens 106
e A e A == 11 T [ PRSP 112
EVENE > EVENT SEHINGS. ...c ettt e e e a et e e e s sttt e e e s b be e e e e e aabeeeeeeeanbaeeeeeanes 116
Applications > MOtION AEIECHON.........e e e e e e e e e e e e e e e et e e e e e e e e e e eeeeeaerasaaranaaanan 130
Applications > Tampering deteClON ..........ooo i 133
Applications > Package management - a.k.a., VADP (VIVOTEK Application Development Platform) ............. 134
Recording > ReCording SEHINGS ... ..ooiiiiiiiiie ettt ettt e e e st e e s e enbe e e e e e abraeeeeeanes 137
Local storage > SD card ManagEmMENT...........ciiuuiiiieiiiiiie e e ittt e e ettt e e e sttt e e e s steeeeeesastaeeeesssseeeesaanteeaesanseneaeeaanes 142
Local storage > Content ManagemeENnt ..........coi ittt e et e e e s abb e e e e s anbe e e e e abbeeeeeane 143

LAY o] 7= o o 3 PP UP TR PR VRPN 146

URL Commands for the NetWOIrK CamEra...... ... et e et e e e e e e e e e aean 146



TechNOlOgy LICENSE NOLICE. ...ttt r e e e e e e s e e b e e e eeeeaeaeeeas 366
Electromagnetic Compatibility (EMC).........ooiiiiiiiiiei et e e 367

Overview

The IB9368 and I1B9388 series is an outdoor bullet network camera capable of 2560 x
1920 resolution at 20 fps with the WDR function enabled. The 2MP IB9368 is capable of
the 1920 x 1080 resolution at 30 fps. At the 5MP resolution and with the WDR function
enabled, the frame rate of IB9388 is slightly reduced to 20fps. The firmware comes with
another 4MP resolution mode with a 30fps frame rate. With the most updated VIVOTEK
WDR Pro technology, the camera series is capable of capturing the highest quality images
in both low light and high contrast environments.

With a remote focus lens, the camera can be used to cover areas of your interest at a
flexible distance range. This also brings the ease of installation.

The cameras support WDR function at the effectiveness of up to 120dB. These models
support local video stroage on the MicroSD cards if network service should be interrupted.
The cameras also come with configurable motion detection and tampering detection with
up to 5 privacy mask areas.



Revision History

m Rev. 1.0: Initial release.

Read Before Use

The use of surveillance devices may be prohibited by law in your country. The Network Camera
is not only a high-performance web-ready camera but can also be part of a flexible surveillance
system. It is the user’s responsibility to ensure that the operation of such devices is legal before
installing this unit for its intended use.

It is important to first verify that all contents received are complete according to the Package
Contents listed below. Take note of the warnings in the Quick Installation Guide before the Network
Camera is installed; then carefully read and follow the instructions in the Installation chapter to
avoid damage due to faulty assembly and installation. This also ensures the product is used
properly as intended.

The Network Camera is a network device and its use should be straightforward for those who
have basic networking knowledge. It is designed for various applications including video sharing,
general security/surveillance, etc. The Configuration chapter suggests ways to best utilize the
Network Camera and ensure proper operations. For creative and professional developers, the URL
Commands of the Network Camera section serves as a helpful reference to customizing existing
homepages or integrating with the current web server.



Package Contents

m |B9368-HT or IBO388-HT
m Screw pack and side lid.
m Sunshield and screw.

m Quick Installation Guide.
m Waterproof cable gland.

/\ WARNING:

1. IR lights emit from this product.
2. Use appropriate shielding or eye protection.

Symbols and Statements in this Document

INFORMATION: provides important messages or advices that might help prevent
inconvenient or problem situations.

NOTE: Notices provide guidance or advices that are related to the functional integrity of
the machine.

o\ Tips: Tips are useful information that helps enhance or facilitae an installation, function,
@ or process.

A WARNING: or IMPORTANT:: These statements indicate situations that can be
dangerous or hazardous to the machine or you.

& Electrical Hazard: This statement appears when high voltage electrical hazards might
occur to an operator.

/\ IMPORTANT:

1. The camera is only to be connected to PoE networks without routing to outside plants.
2. For PoE connection, use only UL listed I.T.E. with PoE output.

1. La caméra ne doit étre raccordée qu’a des réseaux PoE, sans routage vers des
installations extérieures.

2. Pour les raccordements PoE, utilisez uniquement un équipement de Tl homologué UL,
avec une sortie PoE.

Use the camera only with a DC power supply that is UL listed, and limited power source
(LPS) certified. The power supply should bear the UL listed and LPS marks. The power
supply should also meet any safety and compliance requirements for the country of use.

n’utilisez la caméra qu’avec un bloc d’alimentation CC homologué UL, ainsi qu’avec
une alimentation limitée (LPS) certifiée. Le bloc d’alimentation doit porter les indications
d'homologation UL et LPS. Il doit également répondre aux exigences en matiére de
sécurité et de conformité relatives au pays d’utilisation.



VIVOTEK

Physical Description

Outer View

Sunshield

Inner View

ﬁ"

L

MicroSD card slot

Reset button
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VIVOTEK

J NOTE:

Some of the suffix syntax used in model naming are listed below:

E w/ heater for extreme weather

Fx Focal length w/ number

T w/ Remote focus lens

R w/ PoE repeater

H w/ High Dynamic Range functionality

User's Manual - 7




VIVOTEK

Hardware Installation

/\ IMPORTANT:

If you plan to use the Human Detection feature, make sure you measure the height of your
camera. The height information is important for the accuracy of the video analytics results.
Some of the other perspective information are automatically collected by the onboard
S-sensor. The height information enables the horizontal and vertical keystone corrections
of the field of view.

Installation
height

8 - User's Manual




1.Jot down the camera's MAC address for later reference.

Network Camera ¥ vivorEk

Model No: XXXXXX
(MAC: 0002D10766AD )

NONAAPRIN - rons
CEFEQ @

Pat.6, 930, 709 Made in Taiwan

2.0pen the hatch at the bottom of the camera, and install a MicroSD card if onboard
storage is preferred.

T

" ©

button



VIVOTEK

3. Use the alignment sticker to drill mounting holes on the wall or ceiling. Drill a cabling
routing hole if preferred.

O

V7))

Alignment Sticker 4

e

=)

4. Route an Ethernet cable through the cabling hole.

@
\\
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5. Pass an Ethernet cable through the waterproof cable gland components, and through
the rubber seal as shown below. Connect the Ethernet cable to the camera's RJ45

connector.

\) v,

6. Install the seal ring and tighten the waterproof components.




VIVOTEK

7.Connect a ground wire to the grounding position at the back of the camera using the
included screw.

8. Install the sunshield using a flat-blade screwdriver.

12 - User's Manual




9. Install the camera to wall using the included screws. Note that if a routing hole through
the wall is not possible, you can also route the cable through the side opening.

<10 kgf-cm

L Note that it is always a good practice to form a drip loop of cables. Moisture
'@' condensation or dripping water can eventually cause problems without the drip
loop.

b

|
V‘I

PoE

0
O
N S
ﬂ!I\HIN!~ iﬂ!""‘q!
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10. Please visit VIVOTEK’s website to Install the "Shepherd” software utility. The program
will search for VIVOTEK Video Receivers, Video Servers or Network Cameras on the

same LAN.

Double-click on the camera’s MAC address to open a web console with the camera.

IEEE 802.3

Software Installation

11. Install the Shepherd utility, which helps you locate and configure your Network Camera
in the local network. If your camera comes without the CD, go to VIVOTEK’s website,

and locate the utility in the Downloads > Software page.

% wv@E“ Products Suppoet Dorwvnloads Folumnnns L
F |




11-1. Run the Shepherd utility.

11-2. The program will conduct an analysis of your network environment.

1 3 device(s)] lound 5
o ke s

11-3. The program will search for all VIVOTEK network devices on the same LAN.

11-4. After a brief search, the installer window will prompt. Click on the MAC and model
name that matches the one printed on the product label. You can then double-click on
the address to open a management session with the Network Camera.

MAC:0002D1730202 RoHsc € 0

0 FC

00-02-D1-73-02-02
0002D1730202




VIVOTEK

Forceful Password Configuration

12. The first time you log in to the camera, the firmware will prompt for a password
configuration for security concerns.

12-1. Since your camera is used for the first time, there is no password. Enter “root” as the
user name, and nothting for the password.

The server 169.234.203.23% is asking for your user name and
password. The server reports that it is from streaming_server.

VWarning: Your user name and password will be sent using basic
authentication on a connection that isn’ t secure.

[ root
ﬁ [
Remember my credentials

12-2. Enter the combination of alphabetic and numeric characters to fulfill the password
strength. requirement. The default name for the camera administrator is “root”, and can
not be changed.

1
1
Weww. vivoTE-. Som

Language

Configure password

At lzast 8 characters with no space, one alphabet
character{uppercase or lowarcase), and one numeric

character

User name - root

User passwnrd - |.ll..-l..l...l | Madivm
Cunﬁm‘ USEF mssmrd - |.ll..-...-...l| . |

Enable https connection to secure the
configuration for password

*The naw password will be applied to all connections

Save Cancel

16 - User's Manual




VIVOTEK

Some, but not all special ASCII characters are supported: !, $, %, -, ., @, *, _, and ~.
You can use them in the password combination.

You have used invalid characters. These characters are valid:A-Z,
a-z, -9 and 15%-.@"_~

12-3. Another prompt will request for the password you just configured. Enter the password
and then you can start configure your camera and see the live view.

The server 169.254.205.23% is asking for your user name and
password. The server reports that it is fram streaming_server.

Warning: Your user name and password will be sent using basic
authentication on a connection that isn’ tsecure.

oo |

(esecccccscceces |
Remember my credentials

(= J[ &= |

User's Manual - 17




VIVOTEK

13. Remove the protective sheet in front of the lens.

14. Loosen the retention screws on the mount bracket.

N

|

)

-----o

T10
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15. With a live view on your computer, rotate, pan, or tilt the camera until you acquire an
optimal field of view.

16. From a web console, open the firmware configuration page. Enter the Configuration >
Media > Image > Focus page. You will see a live stream on screen. If preferred, you
can zoom in on the scene. Use the “Perform Auto Focus” function to automatically tune
to a best image focus. Check the live view to ensure the image is in focus.

Configuration > Media > Image > Focus

3 4§ NOTE:
Fem sl Q = The "T" models comes with a motorized

RPN focus lens.
Ful-rarge stin o Fullj-opered mi Porioen i foces




Hardware Reset

The reset button is used to reset the system or restore the factory default settings.
Sometimes resetting the system can return the camera to normal operation. If the system
problems remain after reset, restore the factory settings and install again.

Reset: Press the recessed reset button. Wait for the Network Camera to reboot.

Restore: Press and hold the reset button until the status LED rapidly blinks. Note that all
settings will be restored to factory default. Upon successful restore, the status LED will
blink green and red during normal operation.

MicroSD/SDHC/SDXC Card Capacity

This network camera is compliant with MicroSD/SDHC/SDXC 16GB / 8GB / 32GB / 64GB
/ 128GB and other preceding standard SD cards.



Network Deployment
General Connection (PoE)

O When using a PoE-enabled switch

The Network Camera is PoE-compliant, allowing transmission of power and data via a sin-
gle Ethernet cable. Follow the below illustration to connect the Network Camera to a PoE-
enabled switch via Ethernet cable.

802.3af PoE Switch

O When using a non-PoE switch

Use a PoE power injector (optional) to connect between the Network Camera and a non-
PoE switch.

Loy,

b

PoE Power Injector
(optional)

Non-PoE Switch

J NOTE:

1. The camera is only to be connected to PoE networks without routing to outside plants.
2. For PoE connection, use only UL listed I.T.E. with PoE output.



Ready to Use

1.A browser session to the Network Camera should prompt as shown below.

2.You should be able to see live video from your camera. You may also install the
32-channel recording software from the software CD in a deployment consisting of
multiple cameras. For its installation details, please refer to its related documents.

% viversx IB936B-HT

e[t >
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Internet connection via a router

Before setting up the Network Camera over the Internet, make sure you have a router and follow
the steps below.

1. Connect your Network Camera behind a router, the Internet environment is illustrated below.

Regarding how to obtain your IP address, please refer to Software Installation on page 20 for
details.

(B I &
|
IP address : 192.168.0.3
WAN (Wide Area Network )

Router TP address : from ISP Subnet mask : 255.255.255.0
outer IP address  from 15 Default router : 192.168.0.1

Internet

LAN (Local Area Network)
Router IP address : 192.168.0.1

Cable or DSL Modem N [‘gj
—

IP address : 192.168.0.2
Subnet mask : 255.255.255.0
Default router : 192.168.0.1

2. In this case, if the Local Area Network (LAN) IP address of your Network Camera is
192.168.0.3, please forward the following ports for the Network Camera on the router.

m HTTP port: default is 80

m RTSP port: default is 554

m RTP port for video: default is 5556
m RTCP port for video: default is 5557

If you have changed the port numbers on the Network page, please open the ports
accordingly on your router. For information on how to forward ports on the router, please refer
to your router’s user’s manual.

3. Find out the public IP address of your router provided by your ISP (Internet Service Provider).
Use the public IP and the secondary HTTP port to access the Network Camera from the
Internet. Please refer to Network Type on page 80 for details.

Internet connection with static IP

Choose this connection type if you are required to use a static IP for the Network Camera.
Please refer to LAN setting on page 79 for details.

Intern nnection via PPPoE (Point-to-Point over Ethern

Choose this connection type if you are connected to the Internet via a DSL Line. Please refer to
PPPoE on page 80 for details.



For example, your router and IP settings may look like this:

Device IP Address: internal port  |IP Address: External Port (Mapped
port on the router)

Public IP of router 122.146.57.120

LAN IP of router 192.168.2.1
Camera 1 192.168.2.10:80 122.146.57.120:8000
Camera 2 192.168.2.11:80 122.146.57.120:8001

Configure the router, virtual server or firewall, so that the router can forward any data com-
ing into a preconfigured port number to a network camera on the private network, and
allow data from the camera to be transmitted to the outside of the network over the same
path.

From Forward to
122.146.57.120:8000 [192.168.2.10:80
122.146.57.120:8001 [192.168.2.11:80

When properly configured, you can access a camera behind the router using the HTTP
request as follows: http://122.146.57.120:8000

If you change the port numbers on the Network configuration page, please open the ports
accordingly on your router. For example, you can open a management session with your
router to configure access through the router to the camera within your local network.
Please consult your network administrator for router configuration if you have troubles with
the configuration.

For more information with network configuration options (such as that of streaming ports),
please refer to Configuration > Network Settings. VIVOTEK also provides the automatic
port forwarding feature as an NAT traversal function with the precondition that your router
must support the UPnP port forwarding feature.

Gaf # pddreas autcrmabcaly

ey Lse Bxed P addness

Sfrearmang piabndoie ¥ Ennbie UPs@ preseniaion

el #] Enakie UPrP por farwarding

Gl PRRGE

SN 4| Enabie PvE

The device m coafigunng now. Vit Brow et will reconnact

Sascurity IPwE inlGETmy e RHp 0SS 1684 a0 B
u H tha connacion Inis, pleass manualy anber the sbova F
PIZ aniaaly
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Accessing the Network Camera

This chapter explains how to access the Network Camera through web browsers, RTSP players,
3GPP-compatible mobile devices, and VIVOTEK recording software.

Using Web Browsers

Use Installation Wizard 2 (IW2) to access the Network Cameras on LAN.

If your network environment is not a LAN, follow these steps to access the Netwotk Camera:

1. Launch your web browser (e.g., Microsoft® Internet Explorer or Mozilla Firefox).

2. Enter the IP address of the Network Camera in the address field. Press Enter.

3. Live video will be displayed in your web browser.

4. If it is the first time installing the VIVOTEK network camera, an information bar will prompt as
shown below. Follow the instructions to install the required plug-in on your computer.

Dt bl e =]

[] A
A P i @ -5 S [ ¢ TR
M 0 . i i o e ¢ | iy
T T T PP
I v Y vivemEx Mega-Pikal Natwaork Camara
Y viverr Mega-Pixel Network Camera A
RET o Frutn 0 g e L P s e B el i S ol oo o 2aalle ket .-‘-_‘E"- iy .— s
i re i oo b e s H
:E" CUFSIMCYCTEER NP s e .
:
|

NOTE:

» For Mozilla Firefox or Chrome users, your browser will use QuickTime to stream the live
video. If you don’t have QuickTime on your computer, please download it first, then launch
the web browser.

i s o — | et | e | e w————— [hre | [ = @

¥ viversx Mega-Pixel Network Camera Y vivamek Mega-Pixel Matwork Camera
e R

ratatrrd
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» By default, the Network Camera is not password-protected. To prevent unauthorized access,
it is highly recommended to set a password for the Network Camera.
For more information about how to enable password protection, please refer to Security on
page 97.

» If you see a dialog box indicating that your security settings prohibit running ActiveX®
Controls, please enable the ActiveX® Controls for your browser.

1. Choose Tools > Internet Options > Security > Custom Level.

Internet Options

General| Secuity | Privacy | Content | Connections | Programs | Advanced

Select a'web content zone to specify itz security settings.

® €« 0 @
Localintranet  Trusted sites  Restricted
gihes

Internet

Thiz zohe containg all 'web sites you
haven't placed in ather zones

Security level for this zone

Custom
Cusztom zettings.
- To chahge the settings, click Customn Level.
- Ta use the recommended settings, click Default Level

’ Custom Lewvel .. ] Default Level ]

[ 0k H Canicel ]

2. Look for Download signed ActiveX® controls; select Enable or Prompt. Click OK.

Setkings:

Activer controls and plug-ins ”
E] Dovnload signed Activer controls
() Disable
II:II Enable
(@) Promnpk
] Download unsigned Activei conkrols
() Disable
IIEII Enable
'Z:_:Z' Pronipk
E] Initialize and scripk ActiveX controls nok marked as safe
() Disable
IIEII Enable
'Z:_:Z' Pronipk

[ I TSI, WS SRy ¥ R SpRpy ey PRppepups [Py RPpepr R,

£ b4

Reset cuskom setkings

Reset ka: | Medium b

[ oK l[ Cancel ]

3. Refresh your web browser, then install the ActiveX® control. Follow the instructions to
complete installation.



A IMPORTANT:

Currently the Network Camera utilizes a 32-bit ActiveX plugin. You CAN NOT open a
management/view session with the camera using a 64-bit |IE browser.
If you encounter this problem, try execute the lexplore.exe program from C:\Windows\
SysWOW®64. A 32-bit version of IE browser will be installed.
On Windows 7, the 32-bit explorer browser can be accessed from here:

C:\Program Files (x86)\Internet Explorer\iexplore.exe

If you open a web session from the Shepherd utility, a 32-bit IE browser will be
opened.

-‘@’- Tips:
1. The onscreen Java control can malfunction under the following situations: A PC con-

nects to different cameras that are using the same IP address (or the same camera

running different firmware versions). Removing your browser cookies will solve this
problem.

. If you encounter problems with displaying the configuration menus or Ul items, try dis-
able the Compatibility View on IE8 or IE9.

e

You may also press the F12 key to open the developer tools utility, and then change the
Browser Mode to the genuine IE8 or IEQ mode.

v joinsmsn.com D~|Ric X

<le> El@
File Find Disable View Images Cache Tools Yalidate Document Mode: [EQ standards =
HTML | €55 Console Script  Profiler Metwork Internet Explorer 7 R
h = | 4 B Eil Internet Explorer &

-~ <1DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 - v | Internet Explorer

+-<html xmlns="http://www.i /1999 xhtml"> Internet Explorer 8 Compatibility View

In the event of plug-in compatibility issues, you may try to uninstall the plug-in that was
previously installed.

Business Explorer
Camera Stream Controller
¢ Uninstall

Catalyst Cantrol Center

m



Using RTSP Players

To view the streaming media using RTSP players, you can use one of the following players that
support RTSP streaming.

(ﬁ Quick Time Player
;f}, VLC media player

1. Launch the RTSP player.

2. Choose File > Open URL. A URL dialog box will pop up.

3. The address format is rtsp://<ip address>:<rtsp port>/<RTSP streaming access name for
stream1 or stream2>

As most ISPs and players only allow RTSP streaming through port number 554, please set the
RTSP port to 554. For more information, please refer to RTSP Streaming on page 87.
For example:

Enter an Intermet LIRL to open:

risp://192.168.5.151:554/live1s1.50p | v|

4. The live video will be displayed in your player.
For more information on how to configure the RTSP access name, please refer to RTSP
Streaming on page 87 for details.
| e EE

Fig - Edtc. Vaww Window _Haln
Video 16:38:01 2012/01/25

o —) —

/ g \ -wll ¥ -'F.-\'-u -~ -..1
\R—-_._____\___ AR 1) (PR _'_._____,_--—""_F".
| = ]




Using 3GPP-compatible Mobile Devices

To view the streaming media through 3GPP-compatible mobile devices, make sure the Network
Camera can be accessed over the Internet. For more information on how to set up the Network
Camera over the Internet, please refer to Setup the Network Camera over the Internet on page

21.

To utilize this feature, please check the following settings on your Network Camera:

1. Because most players on 3GPP mobile phones do not support RTSP authentication, make
sure the authentication mode of RTSP streaming is set to disable.
For more information, please refer to RTSP Streaming on page 87.

2. As the the bandwidth on 3G networks is limited, you will not be able to use a large video size.
Please set the video streaming parameters as listed below.
For more information, please refer to Stream settings on page 69.

Video Mode H.264
Frame size 176 x 144
Maximum frame rate 5 fps
Intra frame period 1S

Video quality (Constant bit rate) 40kbps

3. As most ISPs and players only allow RTSP streaming through port number 554, please set
the RTSP port to 554. For more information, please refer to RTSP Streaming on page 87.

4. Launch the player on the 3GPP-compatible mobile devices (e.g., QuickTime).

5. Type the following URL commands into the player.
The address format is rtsp://<public ip address of your camera>:<rtsp port>/<RTSP streaming

access name for stream # with small frame size and frame rate>.
For example:

i

Enter an Internet UAL to open:
|rtsp//192.168.4.147:554/lived sdp =]

OF. | Cancel |

You can configure Stream #2 into the suggested stream settings as listed above for live
viewing on a mobile device.



Using VIVOTEK Recording Software

The product software CD also contains a VAST recording software, allowing simultaneous
monitoring and video recording for multiple Network Cameras. Please install the recording
software; then launch the program to add the Network Camera to the Channel list. For detailed
information about how to use the recording software, please refer to the user’s manual of the
software or download it from http://www.vivotek.com.

-‘@’- Tips:
1. If you encounter problems with displaying live view or the onscreen plug-in control, you may try

to remove the plug-ins that might have been installed on your computer. Remove the following
folder: C:\Program Files (x86)\Camera Stream Controller\.

2. If you forget the root (administrator) password for the camera, you can restore the camera
defaults by pressing the reset button for longer than 5 seconds.

3. If DHCP is enabled in your network, and the camera cannot be accessed, run the Shepherd
utility to search the network. If the camera has been configured with fixed IP that does not
comply with your local network, you may see its default IP 169.254.x.x. If you still cannot find
the camera, you can restore the camera to its factory defaults.

4. If you change your network parameters, e.g., added a connection to a LAN card, re-start the
Shepherd utility.


http://www.vivotek.com

Main Page

This chapter explains the layout of the main page. It is composed of the following sections:
VIVOTEK INC. Logo, Host Name, Camera Control Area, Configuration Area, Menu, and Live
Video Window.

Resize Buttons

VIVOTEK INC. i — IBOIEE-HT
Logo

[ Em—— |
s

Host Name

Configuration
Area

Camera Control
Area

]

Live View Window

VIVOTEK INC. Logo
Click this logo to visit the VIVOTEK website.

Host Name

The host name can be customized to fit your needs. The name can be changed especially there are many
cameras in your surveillance deployment. For more information, please refer to System on page 42.

Camera Control Area

Video Stream: This Network Camera supports multiple streams (streams 1 and 2) simultaneously. You

can select any of them for live viewing. For more information about multiple streams, please refer to page
69 for detailed information.

Manual Trigger: Click to enable/disable an event trigger manually. Please configure an event setting on
the Application page before you enable this function. A total of 3 event configuration can be configured.
For more information about event setting, please refer to page 115. If you want to hide this item on
the homepage, please go to Configuration> System > Homepage Layout > General settings >
Customized button to deselect the “show manual trigger button” checkbox.




Configuration Area

Client Settings: Click this button to access the client setting page. For more information, please refer to
Client Settings on page 36.

Configuration: Click this button to access the configuration page of the Network Camera. It is suggested
that a password be applied to the Network Camera so that only the administrator can configure the
Network Camera. For more information, please refer to Configuration on page 41.

Language: Click this button to choose a language for the user interface. Language options are available

in: English, Deutsch, Espafiol, Frangais, Italiano, P # 3, Portugués, f§ i+ ¥ <, and %% <~ . Please
note that you can also change a language on the Configuration page; please refer to page 41.

Hide Button
You can click the hide button to hide or display the control panel.

Resize Buttons

B Aurbof B 1004 EH 50% [ Bd 25% |

Click the Auto button, the video cell will resize automatically to fit the monitor.
Click 100% is to display the original homepage size.

Click 50% is to resize the homepage to 50% of its original size.

Click 25% is to resize the homepage to 25% of its original size.

Live Video Window

m The following window is displayed when the video mode is set to H.264 or H.265:
H.265/264 Protocol and Media Options
Video Title [ vided (TPC-AV) 2018/03/25 17:08:56 Time
Title and Time | Video 17:0856 2018/03/25 I

Zoom Indicator

Video Control Buttons

Video Title: The video title can be configured. For more information, please refer to Video Settings on
page 54.

H.264 or H. 265 Protocol and Media Options: The transmission protocol and media options for H.264 or
H.265 video streaming. For further configuration, please refer to Client Settings on page 36.

Time: Display the current time. For further configuration, please refer to Media > Image > Genral settings
on page 54.

Title and Time: The video title and time can be stamped on the streaming video. For further configuration,
please refer to Media > Image > General settings on page 59.



PTZ Panel: This Network Camera supports “digital“ (e-PTZ) pan/tilt/zoom control, which allows roaming
a smaller view frame within a large view frame. Please refer to PTZ settiings on page 112 for detailed
information.

Global View: Click on this item to display the Global View window. The Global View window contains a
full view image (the largest frame size of the captured video) and a floating frame (the viewing region of
the current video stream). The floating frame allows users to control the e-PTZ function (Electronic Pan/
TiltYZoom). For more information about e-PTZ operation, please refer to E-PTZ Operation on page 112.
For more information about how to set up the viewing region of the current video stream, please refer to
page 112.

= Global View:

The viewing region of
the curruent video
stream

The largest frame size

Maving Instantly

Note that the PTZ buttons on the panel are not operational unless you are showing only a portion of the
full image. If the live view window is displaying the full view, the PTZ buttons are not functional.



Video Control Buttons: Depending on the Network Camera model and Network Camera configuration,
some buttons may not be available.

¥ Snapshot: Click this button to capture and save still images. The captured images will be displayed
in a pop-up window. Right-click the image and choose Save Picture As to save it in JPEG (*.jpg) or BMP
(*.bmp) format.

b Digital Zoom: Click and uncheck “Disable digital zoom” to enable the zoom operation. The navigation
screen indicates the part of the image being magnified. To control the zoom level, drag the slider bar. To
move to a different area you want to magnify, drag the navigation screen.

Disable digital ptz

Zoom Factar:

-
- 100% 400%
|

@ Pause: Pause the transmission of the streaming media. The button becomes the ' » | Resume button
after clicking the Pause button.

- Stop: Stop the transmission of the streaming media. Click the | ® Resume button to continue

transmission.

B Start MP4 Recording: Click this button to record video clips in MP4 file format to your computer.

Press the El Stop MP4 Recording button to end recording. When you exit the web browser, video
recording stops accordingly. To specify the storage destination and file name, please refer to MP4 Saving

Options on page 37 for details.

=5 Full Screen: Click this button to switch to full screen mode. Press the “Esc” key to switch back to normal
mode.



m The following window is displayed when the video mode is set to MJPEG:
Video Title Video| (HTTP-V) Time

Title and Time |Video17:08:562018/07/25—

Video Control Buttons

Video Title: The video title can be configured. For more information, please refer to Media > Image on
page 59.

Time: Display the current time. For more information, please refer to Media > Image on page 59.

Title and Time: Video title and time can be stamped on the streaming video. For more information, please
refer to Media > Image on page 59.

Video Control Buttons: Depending on the Network Camera model and Network Camera configuration,
some buttons may not be available.

E Snapshot: Click this button to capture and save still images. The captured images will be displayed
in a pop-up window. Right-click the image and choose Save Picture As to save it in JPEG (*.jpg) or BMP
(*.bmp) format.

IE Digital Zoom: Click and uncheck “Disable digital zoom” to enable the zoom operation. The navigation
screen indicates the part of the image being magnified. To control the zoom level, drag the slider bar. To
move to a differeptaras uaiwant ta mannifis deaa tha naviaatian gcreen.

[C] Disable digital ptz

Zoom Factor:
A

. 100%

I

F Start MP4 Recording: Click this button to record video clips in MP4 file format to your computer.
Press the El Stop MP4 Recording button to end recording. When you exit the web browser, video
recording stops accordingly. To specify the storage destination and file name, please refer to MP4 Saving
Options on page 37 for details.

ﬁ Full Screen: Click this button to switch to full screen mode. Press the “Esc” key to switch back to normal
mode.



Client Settings

This chapter explains how to select the stream transmission mode and saving options on the
local computer. When completed with the settings on this page, click Save on the page bottom
to enable the settings.

H.265/H.264 Protocol Options

H.265/H.264 protocol options
TCP v

Depending on your network environment, there are four transmission modes of H.264 streaming:

UDP unicast: This protocol allows for more real-time audio and video streams. However, network
packets may be lost due to network burst traffic and images may be broken. Activate UDP connection
when occasions require time-sensitive responses and the video quality is less important. Note that each
unicast client connecting to the server takes up additional bandwidth and the Network Camera allows up
to ten simultaneous accesses.

UDP multicast: This protocol allows multicast-enabled routers to forward network packets to all clients
requesting streaming media. This helps to reduce the network transmission load of the Network Camera
while serving multiple clients at the same time. Note that to utilize this feature, the Network Camera must
be configured to enable multicast streaming at the same time. For more information, please refer to
RTSP Streaming on page 87.

TCP: This protocol guarantees the complete delivery of streaming data and thus provides better video
quality. The downside of this protocol is that its real-time effect is not as good as that of the UDP protocol.

HTTP: This protocol allows the same quality as TCP protocol without needing to open specific ports for
streaming under some network environments. Users inside a firewall can utilize this protocol to allow
streaming data through.



MP4 Saving Options

MP4 saving options

Falder: Cl\Record

File name prefix CLIP

Add date and ime sufiixic file name

Users can record live video as they are watching it by clicking | ®  Start MP4 Recording on the main
page. Here, you can specify the storage destination and file name.

Folder: Specify a storage destination on your PC for the recorded video files. The location can be
changed.

File name prefix: Enter the text that will be appended to the front of the video file name. A specified folder
will be automatically created on your local hard disk.

Add date and time suffix to the file name: Select this option to append the date and time to the end of the
file name.

( 1\

CLIP_20190321-180853

1

File name prefix Date and time suffix
The format is: YYYYMMDD_HHMMSS

Local Streaming Buffer Time
Local streaming buffer time

0 Millisecond

| Save |

In the case of encountering unsteady bandwidth, live streaming may lag and video streaming may not be
very smoothly. If you enable this option, the live streaming will be stored temporarily on your PC’s cache
memory for a few milli seconds before being played on the live viewing window. This will help you see
the streaming more smoothly. If you enter 3,000 Millisecond, the streaming will delay for 3 seconds.



Joystick settings

Enable Joystick

Connect a joystick to a USB port on your management computer. Supported by the plug-in
(Microsoft’s DirectX), once the plug-in for the web console is loaded, it will automatically detect if
there is any joystick on the computer. The joystick should work properly without installing any other
driver or software.

Then you can begin to configure the joystick settings of connected devices. Please follow the
instructions below to enable joystick settings.

1. Select a detected joystick, if there are multiple, from the Selected joystick menu. If your joystick
is not detected, if may be defective.

2. Click Calibrate or Configure buttons to configure the joystick-related settings.

Joystick settings

Selected joystick: | (TSI T |
| Calibrate | | Configure buttons
| Save |
{) NOTE:

+ If you want to assign Preset actions to your joystick, the preset locations should be configured
in advance in the Configuration > PTZ page. In Windows, use the search function on the Start
menu to search for Game Controller.

+ If your joystick is not working properly, it may need to be calibrated. Click the Calibrate button
to open the Game Controllers window located in Microsoft Windows control panel and follow the
instructions for trouble shooting.

* The joystick will appear in the Game Controllers list in the Windows Control panel. If you want to
check out for your devices, go to the following page: Start -> Control Panel -> Game Controllers.

Game Controllers E]E]

2. These settings help you configure the game controllers inztalled on
I

"TU 5
'J":: your computer.

Inztalled game contrallers

Contraller Status
CH FRODUCTS IF DESKTOF COMTROLLER

Add... ] [ Femaove ] [ Properties ]

[ Advanced... ][ Troublezhoat... ]




Buttons Configuration

In the Button Configuration window, the left column shows the actions you can assign, and the right
column shows the functional buttons and assigned actions. The number of buttons may differ from

different joysticks.

Please follow the steps below to configure your joystick buttons:
1. Choosing one of the actions and click Assign will pop up a dialog. Then you can assign this

action to a button by pressing the joyst